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Presentation Notes




Topics

020 Field - Paperback and Hardbacks in Polaris
082 Field - Dewey Dates

245 Field - GMDs

264 Field - Dates

300 Field — Pagination, runtime, extent, etc.

504 Field — Index and bibliographical references
650 vs. 655 Fields — Subject vs. Genre Headings
650/655 Fields - Subject Headings to Change
650/655 Fields - Subject Headings to Remove
Bootlegs, Pre-Pubs, ARCs

Volume Field Usage in Polaris

On-Order Records

Constant Data & Text Strings in Connexion Client
Policies and Procedures
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020 Field: Paperbacks and Hardbacks in
Polaris

« Hardbacks and paperbacks can be on the same record if
certain conditions are met.

1. All searching and matching criteria are met (size, pagination,
publication year, etc.)
« Exception: In cases where the presence of a hardback or paper edition

statement is the only difference, both edition statements may be included in
the Polaris record
250 _ _ $a First hardback edition, 1st paperback edition

« An ISBN on a matching item should be added to the
bibliographic record if not already present.
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082 Field - Dewey Dates

« If you assign a Dewey Decimal Classification number according to the DDC
schedules or to LC practice, use field 082 with (typically) 1st indicator 0 and 2nd
indicator 4.

082 04 $a

« $2 Edition Information
 Assigned from a printed edition (edition/language of edition/pub year of edition):

$2 23/eng/2012

 Assigned from an electronic version (edition/language of edition/date on which
the number was assigned by the cataloger):

$2 23/eng/20240403
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1XX Fields — Main Entry

« $0 Authority record control number or standard number

« System control number of the related authority or classification record, or a
standard identifier such as an International Standard Name Identifier (ISNI)

« $1 Read World Object URI

+ ldentifies an entity, sometimes referred to as a Thing or Real World Object
(RWO), whether actual or conceptual.

* OCLC is adding these.

* Do not remove if in the record, but it is not necessary to add them in if it
IS not present.
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SO & S1 Examples

100 1 Obama, Michelle, #d 1964- e author #1 hitp://viaf.org/viaf/81404344
100 1 Jemison, Mae, #d 1965- e author #1 http://id.loc.gov/rwo/agents/n95004729
100 1 Childress, Eric, e author #1 https://isni.org/isni/0000000043605828 *#1 https://orcid.org/0000-0002-7442-635X #0 (viaf)36648407

[ltem cataloged in English (i.e., 040 b eng) with an uncontrolled access point with ISNI, ORCID, and VIAF standard identifiers]

348 score ¥2 rdafnm 0 http://rdaregistry.info/termList/formatNoteMus/1007
[Vocabulary term with a link to RDA Format of Notated Music list]

650 7 Local transit #x Ridership #2 fast #0 (OCoLC)fst01001631
[FAST topical subject access point with the control number of the related FAST authority record]

655 7 Life simulation video games #2 olacvggt #0 http://metadataregistry.org/uri/olac/1041
[Genre term with a link to OLAC's Videogame Genre Form Terms]

700 1 Park, Robert Ezra, #d 1864-1944 #0 (NL-LeOCL)069017557
[ltem cataloged in Dutch (i.e., 040 #b dut) with an access point controlled to a record in the NTA Names (Dutch) authority file]
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Presenter Notes
Presentation Notes
You may also see $0 and $1 in other areas of MARC Records such as 300 fields, 600 fields, 700 fields, and 800 fields. 


758 Field — Resource Identifier

 An identifier for a resource that is either described in the bibliographic
record or a resource to which it is related.

* Resources identified can include, but are not limited to:
« FRBR works
* Expressions
 Manifestations
* |ltems

245 1 0 Policy proposal for intercity passenger transport / #c¢ Shigeru Morichi and Surya Raj Acharya
758 Fi has work: ¥a Policy proposal for intercity passenger transport (Text) #1
https://id.oclc.org/worldcat/entity/E39PCGBJ3khghHc98cpkkG9g4y #4 https://id.oclc.org/worldcat/ontology/hasWork

* If founa In a recora, you can Ieave It In, but It IS Not necessary 10 add it
(at this time) if not in the record.

« See PDF Handout on L2 for additional explanation.
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245 Field - GMDs

« SHARE Local Practice Only

A general material designation (GMD) should be added to all
records for braille, large print material, larger print material,
and all non-print formats.

* Add in before the $b or $c field

o %4\5/\/ :] 0 $a Charlotte's web $h [text (large print)] $b a novel / $c by E.
. White.

Use of General Material Designation (gmd) | SHARE
(illinoisheartland.org)
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https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards/350
https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards/350

Currently Available GMDs

» Braille
« $h [braille]

* Electronic resource

« $h [electronic resource]

* Filmstrip
 $h [filmstrip]

* Flash card
« $h [flash card]

e Game
* $h [game]
o Kit
«  $h [kit]
* Microform
« $h [microform]

» Microscope slide

« $h [microscope slide]

Model
« $h [model]

Realia

« $h [realia]
Slide

« $h[slide]
Sound recording

« $h [sound recording]
Text (large print)

« $h [text (large print)]
Toy

» $h[toy]
Transparency

« $h [transparency]

Videorecording
« $h [videorecording]
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264 Field - Dates

* |f publication date stated
0 264_1 $a City, State : $b Publisher, $c year. (period)
0 264_4 $c ©year (no period)

* If publication date not stated, look for implied date, and use
brackets

o Ex: ©2020
= 264_1 $a City, State : $b Publisher, $c [year] (No period)

= 264_4 $c ©year (no period)
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Presentation Notes
If publication date stated -> just use it no brackets. 
If not stated 


To bracket or not to bracket, that is the
guestion

» What does the 264 _1 look like for:
0 ©2020 only date given?
o Publication 2020 only date given
o Publication and Copyright both 2020
o Publication 2017, Copyright 2020
o No publication date given.
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Dtst Fixed Field

Copyright Publication Date

Dtst: "t" and
use the copyright
date in 264, 1
(with brackgts)
and 264 4

4
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What's the Dtst?

g Publication date 2020, copyright date 20207?

Publication date 2020, copyright date 20217?

il

‘H Copyright date 2020, no publication date given?

Publication date 2020, no copyright date?
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300 Field — Physical Description - Books

« $a Extent
« use for the number of pages and/or number of volumes
» Use last numbered page

* If no numbered pages:
» use 1 volume (unpaged)
« If the book is short, you can count pages and say “_ unnumbered pages

« $b Other physical details

« Use for any illustrative matter
* Must match codes in llls field

e $c Dimensions

« Use for the size of the item
* Measure in cm.
» For books that are wider than tall, measure both width and height
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300 Field — Physical Description — Sound
recordings

e $a Extent

» Use for the number of physical units

* Enter the playing time in parentheses following the carrier type
when appropriate

« 300 _ _ 2 audio discs (1 hr., 8 min., 57 sec.)
« $b Other physical details
* Prefer use of 344 for recording sound characteristics

 $c Dimensions

» Use for the size of the item
« $c 4 3/4in.
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300 Field — Physical Description — Visual
materials

e $a Extent

» Use for the number of physical units

* For motion pictures and videorecordings, enter the playing time or number
of frames in parentheses following the carrier type.

300 _ _ $a 3 videodiscs (60 min.)

« $b Other physical details
« Use for the other physical details appropriate to the material

« use for aspect ratio and special projection characteristics, sound
characteristics, color characteristics, and projection speed

$b sound, black and white
$b sound, color

e $¢ Dimensions

 Use for the size of the item
$c 4 3/4 in.
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490 Field — Series Statement

300
336
337
338

90

|

485 pages ; #c 23 cm.

text #b txt +2 rdacontent
unmediated #b n $2 rdamedia
volume #b nc #2 rdacarrier
Path of the ranger ; v 2

* If a 490 is present -> 300 field

MUST end in period.

oOtherwise NO PERIOD at

end of 300 field
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504 Field — Index and bibliographical
references

* 504 field does not necessarily mean includes index.

» Book w/Bibliographical References
o 504 ## Includes bibliographical references (pages X-Y).
o504 ## Includes bibliographical references (pages X-Y) and index.

* Book w/Index Only
o0 500 ## Includes index.

* Don’t forget to change Cont->b and Index->1
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650 vs. 655 Fields — Subject vs. Genre
Headings

« 650 field -> ltem is ABOUT this topic

* 655 field -> Item IS this topic

 What does "650 10 Romance fiction" mean?
* What does "655 #7 Romance fiction" mean?
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650/655 Fields - Subject Headings to
Change

« 650 10 Children stories. (used for children stories)

« 650 10 Large print books (used for large print books)
« 650 10 Cookbooks (used for cookbooks)

« 655 #7 Picture books. $2 Icgft (for all children's books)

o Note: In picture books, illustrations are as important as—or more important than—
the words in telling the story.

* 655 #0 is used in limited situations. Change to 655 #7 for
controlled genre/term headings.
o 655 #7 Large print books. $2 Icgft
o 655 #0 Young adult fiction. (LC Headings Used as Genre Terms)
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650/655 Fields - Subject Headings to
Remove

 Local Changes!
 FAST Headings
« Sears Headings
* BISACSH
 MIGFG (Moving Image Genre-Form)

» Foreign language subject headings if different than the language of
the item being cataloged.

 Juvenile subject headings when they are the same as LC adult

EEEEEEE

658 _ 1 *aPuppiesivFiction. —
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XX Fields

 For records with a 490 field, there can be three options for
the 8XX fields:

o If the series is written by one author and the authority record exists
for that one author's series

= 800 1# Author LN, Author FN. $t Series title.

o If the series is written by multiple authors or by a publishing
company
= 830 #0 Series title.
o If the series does not exist, use a 490 #0

o NOTE: If the series has more than three books, email us and we
can create a local series authority record.
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Bootlegs, Pre-Pubs, ARCs

 The following resources cannot be added to the SHARE
catalog:
« Advance reading copies (ARCs) or uncorrected proofs of books
« Advance screening copies of videos
 Pirated or illegal copies in any format

*Items that are considered to be of historical significance may
be retained but should be marked as non-circulating.
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Volume Field Usage in Polaris

* The volume field in item records is only to be used in specific
circumstances:
 Serials Module — individual issues

« Serial bibliographic record for items that DO NOT circulate in Polaris
« Reference materials, year books, etc.

« Monographic set record for complete works in multiple volumes that
are published in the same year with the same title.
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On-Order Records

* DO NOT circulate on on-order records!

e Creation

» Barcoding libraries not using the acquisitions module may request
on-order bibliographic records be created by Bibliographic Services
staff

 Cataloging libraries not using the acquisitions module can create a
short bibliographic record using one of the on-order bibliographic
record templates created by SHARE staff

 Acquisition libraries will generate records after importing orders.
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On-Order Record Requirements

 The full list of on-order record requirements can be found at
the link below:

 On-order records | SHARE (illinoisheartland.org)

» Applies to on-order records created through Acquisitions
module and an on-order template.

» Missing information from the required list should be added
manually if not included in the record after importing through
the acquisitions module or after using an on-order template.
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https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards/328

On-Order Bib Records and Item Records

e Circulation status must be In-Process or On-Order ONLY.

* On-order item records MUST be marked as Holdable with no
limits even if the library intends to make the item holdable
only by their patrons when it is received

DO NOT enter a barcode in any item record attached to an
on-order bibliographic record
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Presentation Notes
Item records marked as holdable: allows holds to be placed at the bib level by any patron

Barcode: prevents item-specific holds from being placed


Constant Data & Text Strings in Connexion
Client

« Constant data great for saving static fields (ex. 007 fields and 3XX
fields for books/videos/etc.)
o Shortcut for constant data "Ctrl + b"

o Cataloging -> Create -> Constant Data -> Action -> Save Record to Local
File -> Make a memorable name

= |f you forget the name you made, look up all Constant Data by Cataloging ->
Search -> Local constant data -> Enter

 Text string great for adding phrases into fields that are repetitive
(like GMDs or $e author.).

o Text strings -> Add -> Write your repetitive text and name it -> Ok ->
Highlight your new text string -> Keymaps -> Highlight your text string ->
Enter your keyboard shortcut -> OKk.
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Searching for LCSH/Authority Names/Etc.

24 File Cataloging Authorities Edit Action Batch View Tools Window Help

SBAA ARANMA TR RFEEARKE 2L 2R M WE BFR (L ?

0

41

Search LC Names and Subjects X

Browse Authority File X

Command Line Search

Enter keyword, numeric, derived, or browse search here... = Browse for:

s N Canil y holy bible -
Search for: o=
| ~| in[Titles (ti) - =

n-1LC Names v

OR | ~| in|Personal Names (pn)  ~| —

OR ~| ~| in|Personal Names (pn)  ~| Expanded Term:

-

[orR ~| ~| in|Titles (ti:) Jid ‘

orR - ~| in|Topicals (sp)) #

: : Clear Search | Enter Diacritics...

[T Show See References in Results ™ Retain Search

[~ Show See Also References in Results

UK Cancel | Help
0K Cancel Enter Diacritics... Clear Search Help |
A

wms




Resources and Links

« Resources | SHARE (illinoisheartland.org)
« SHARE editing checklists

» Bibliographic & Cataloging Standards | SHARE
(illinoisheartland.org)
* Policies and Procedures

» OCLC Bibliographic Formats and Standards
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https://share.illinoisheartland.org/cataloging/resources
https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards
https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards
https://www.oclc.org/bibformats/en/home.html

	Reminders and Updates
	Topics
	020 Field: Paperbacks and Hardbacks in Polaris
	082 Field - Dewey Dates
	1XX Fields – Main Entry
	$0 & $1 Examples
	758 Field – Resource Identifier
	245 Field - GMDs
	Currently Available GMDs
	264 Field - Dates
	To bracket or not to bracket, that is the question
	Dtst Fixed Field
	What's the Dtst?
	300 Field – Physical Description - Books
	300 Field – Physical Description – Sound recordings
	300 Field – Physical Description – Visual materials
	490 Field – Series Statement
	504 Field – Index and bibliographical references
	650 vs. 655 Fields – Subject vs. Genre Headings
	650/655 Fields - Subject Headings to Change
	650/655  Fields - Subject Headings to Remove 
	8XX Fields
	Bootlegs, Pre-Pubs, ARCs
	Volume Field Usage in Polaris
	On-Order Records
	On-Order Record Requirements
	On-Order Bib Records and Item Records
	Constant Data & Text Strings in Connexion Client
	Searching for LCSH/Authority Names/Etc.
	Resources and Links

